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Class Description 

Can your Revit model be smart AND sexy? Is BIM the end of 2D drawings?  

In this session you will learn how to create stunning views of your model – for presentations, 

publications and competitions.  

What this session is NOT about: Rendering / Detailing. These topics are extensive and may be 

covered in future session.   

 
Key Learning Outcomes: 

 

 

1. Understand the logic of Revit's graphical settings and know how to use them effectively 

2. Be able to create stunning 2D/3D views in Revit for your documentation and tag them with 

intelligent information 

3. Learn how to create an awesome Revit template which will save you a lot of time on future 

projects 

 

 

 

 

About the Speaker: 

 

Lejla Secerbegovic is a digital enthusiast and a licensed architect in Germany 

with 8 years of work experience in architectural offices in Germany and Austria. 

Before joining Autodesk as a Technical Specialist for BIM in 2015, she was working 

as a BIM Manager for the Max Bögl Group where she was responsible for the 

Revit implementation throughout the company.  

 

 

Lejla blogs and tweets regularly on following channels:  

http://twitter.com/archistar 

http://bim-me-up.com 

http://www.autodesk.de/bimblog 

http://twitter.com/archistar
http://bim-me-up.com/
http://www.autodesk.de/bimblog
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It’s all about the I in the BIM 

 

Nothing to discuss about: when it comes to BIM, it definitely matters most which 

information your model holds. This often implies that all information needed will be 

available to everyone in the model itself with no need to deliver 2D documentation.   

 

So - is BIM the end of 2D documentation?  

 

We are still requested to deliver documents which are displaying this information in a 

certain way. No matter whether we are talking about documents to be submitted at 

authorities, competition entries or presentations – we still need to deliver something 

which cannot be misunderstood or misinterpreted, something that is displaying exactly 

what we want and the way we want it. 

 

So what’s all the fuss about it? Architectural drawings are actually nothing more but a 

different representation of the model – the more our software is advancing, the easier it 

gets to create these.  

Maybe it’s about the term itself – drawing implies that it is created manually by drawing 

lines, which is of course not true anymore. Modern documents (drawings) are derived 

from the model and they display the information it contains.  

The drawings (2D as well as 3D) are not going to disappear with BIM – they will evolve.  

 

The first thing we learn at architecture schools is the art of presentation: it doesn’t only 

matter how your building looks like, it matters how you represent it! We are not only 

engineers, we are also artists – of course we care about the information in our models, 

but who said that information can’t be sexy? 

 

Well the good thing is – it can! And in this session I will show you how you can produce 

stunning and appealing views of your model with Revit!  
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Controlling graphical representation in Revit 

 

Revit is indeed not always that intuitive when it comes to controlling if and how you see 

a certain element, especially if you are new to the software. It has its own logic, which is 

based on the BIM method and is very different from what we are used to from CAD.   

 

 

Categories vs. Layers  

There is that certain moment when you are presenting Revit to a CAD-expert and you 

tell him: Revit has no Layers… It will make him speechless and terrified; finally the layer 

structure is one of the main CAD standards.  

But BIM categories, on which the categories of Revit elements are based, offer a lot of 

advantages and a far easier handling. There are 3 main differences between Layers 

and Categories to be kept in mind:  

 

1. Categories are predefined 

You cannot define your own categories, these are based on the nature of the 

elements itself. Therefore, a wall will always be in the wall category, a door in the 

door category etc.  

However, you can define Subcategories for certain elements on your own, which 

we will discuss later.  
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2. Categories define the nature of an element 

Categories are not only useful for graphical representation – they define the 

nature of an element, they make sure that the wall knows it is a wall and that it 

has all necessary properties. Therefore, don’t mess around with categories – there 

are ways to model objects in wrong categories, among which Generic Model is 

definitely the most famous one – please don’t do it.  

You won’t only run into problems with graphical representation, but your model 

will lose its intelligence and will deliver wrong data! 

 

  
 

 

3. Hierarchical visibility per view 

This is the most important difference for us when it comes to graphics: the way 

certain elements in Revit will display is not ruled globally by the layer settings, but 

can be altered using different settings, which will influence each other according 

to their hierarchy. Also, some of these settings are project wide and some only 

valid per view.  

 

On the next page you will see 3 screenshots showing the same door just with 

different detail level and scale settings – this illustrates quite well the power and 

the complexity of the visual settings in Revit.  

 

At the end of this session you will know exactly what you need to set where in 

order to reach exactly what you want.  
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Different representations of the same element in Revit 
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General settings 

 

When setting up the project template, there are some general 

settings which should be reviewed and set up first. These define 

line styles, line patterns and fill patterns.  

 

Line Weights in Revit are already built in and usually don’t 

require any further adaptions. There are 16 predefined weights, 

1 being the thinnest and 16 the thickest line.  

These are set up in such a way that they scale with the drawing 

scale and keep your drawing readable.  

 

 

The Line Patterns in Revit are combined out of Dots, Lines and 

Spaces: 
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Line Styles are combined out of Line Weights, Line Patterns and a color: 

 

 

You may notice there are some styles with brackets <…>  - these line styles are 

hardcoded and used by the system, therefore they can’t be removed or renamed. 

However, you can change their properties, e.g. if you wish you area boundaries to be 

displayed in a different way by default.  

  

Create non-standard Linestyles like the X-Line ( ---X----X----X) by following 

this simple workaround: create a Detail Family containing only the 

Symbol “X”. Finally, use Annotate > Component > Detailed Component 

to repeat the detail family along a line!  
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Fill Patterns in Revit can either be 

Drafting or Model Patterns.  

 

Drafting patterns will scale with the view 

scale, in order to stay readable. These 

are the patterns you typically use as cut 

patterns.  

Model Patterns however will always keep 

their sizing and are typically used for 

surfaces like tiles etc.  

 

 

 

  

 

 

  

1:100 1:50 

1:10 

Model pattern 

Drafting pattern 
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 In order to create a new pattern, existing patterns can be 

adapted using the pattern editor. Simple patterns can also 

be created from scratch using the editor.  

 

Note that only solid lines can be used in order to create 

either parallel lines or a crosshatch. The behavior and the 

orientation of the pattern can be controlled using the 

following options:  

 

Orient to View 

Keeps the pattern always oriented to the view according 

to its angle:  

 

 
Keep readable 

Will orient the pattern depending on the view and the angle of the element itself, 

attempting to find the best option:  

  
 
Align with Element 

Will orient the pattern according to the alignment of the element only 
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More complex patterns can be created by clicking Custom in the Pattern editor and 

loading a pattern file (*.pat).  

These files can be created very easily with AutoCAD or with a text editor. A .pat file can 

contain several patterns and needs to be prepared in text editor for use in Revit.  

 

Before editing the file however, it is important to understand the structure of a .pat file:  

1. Line: Title – starts with a * and can contain max. 31 letters and an optional 

description 

*Name, Description 

2. Line and following (until the next title): Definition – describes the pattern by using 

angles, coordinates and line types 

Angle, x-origin, y-origin, delta-x, delta-y, dash-1, dash-2, …  

 

With AutoCAD installed on a machine, the default pattern files can be found in the 

following folder: 

C:\Program Files\Autodesk\AutoCAD 2017\UserDataCache\en-us\Support 

Eventually, en-us must be changed to match the installed language.  

 

This is an excerpt from the German acadiso.pat file:  

 
*GOST_GROUND,Boden 
45, 0, 0, 10, -10, 20 
45, 3, 0, 10, -10, 20 
45, 6, 0, 10, -10, 20 
*GRASS, Grasfläche 
90, 0, 0, 17.96051224, 17.96051224, 4.7625, -31.15852448 
45, 0, 0, 0, 25.4, 4.7625, -20.6375 
135, 0, 0, 0, 25.4, 4.7625, -20.6375 
*GRATE, Gitterfläche 
0, 0, 0, 0, 0.79375 
90, 0, 0, 0, 3.175  

 
 

  

For more complex patterns, load any CAD pattern using the .pat file 

format!   
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In order to load the Grass pattern in Revit, the highlighted lines above are copied into a 

new textfile and following lines are added:  

 
;%UNITS=MM 
*GRASS, Grasfläche 
;%TYPE=DRAFTING 
90, 0, 0, 17.96051224, 17.96051224, 4.7625, -31.15852448 
45, 0, 0, 0, 25.4, 4.7625, -20.6375  
135, 0, 0, 0, 25.4, 4.7625, -20.6375  

 

The first line describes the units, in which the pattern file has been created. The type 

describes the Revit-type of the pattern, which can either be Model or Drafting.  

This file can now be saved with the extension .pat and loaded in Revit.  

 

Once the pattern file has been prepared for Revit, it can be loaded into the pattern 

editor and even scaled if necessary:  
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Materials 

 

Materials in Revit are very powerful – they don’t only define the graphical 

representation of the elements, but they also carry physical and thermic properties 

which are relevant for calculations and simulations.  

 

The Material Editor is found under the tab Manage:  

 
 

The main functions of the editor are: 
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Every material has tabs Identity, Graphics and Appearance by default. Tabs Physical and 

Thermal can be added if needed.  
 

The tab Identity holds all information about the material, like description, comments, 

tags or information about manufacturer, costs etc.  

 

The tab Graphics define the graphical representations of elements which have this 

material assigned:  

 
 

Shading defines how the material 

will display in shaded views using 

a color / transparency. 

Alternatively the Render 

appearance can be used for 

shaded views as well by 

checking the checkbox, which 

will override the color and the 

transparency set in this dialog.  

 

Surface pattern is the pattern 

which will be used in addition to 

the shading color chosen above 

for shaded views, but also for 

wireframe and hidden line view 

options.  

Cut pattern will be used for all 

surface in a view that are cut, 

e.g. walls in a ground view.  
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The tab Appearance defines the representation of the material when rendered or 

displayed in a realistic display mode.  

While the properties for Identity and Graphics are stored in the project file only, the 

properties found in the appearance tab can be loaded from the object library. This is 

why additional information, description and keywords can be added in this tab as well.  

 

For shared tabs as this one it is 

important to notice that these are 

stored once in the library and can 

be reused for different materials. 

Changing one value in the tab 

may therefore affect other 

materials as well.  

 

Depending on the material 

loaded, the properties available 

in this tab may vary. In general, 

they offer the possibility to define 

a color by either choosing an 

explicit RGB value or by an 

image.  

In addition, an image for the finish 

bump can be added as well. This 

is typically the same image 

defining the color, but reduced to 

black/white colors which define 

the embossment. The file for the 

finish bumps is typically created in 

a photo-editing tool like Adobe 

Photoshop or Autodesk Pixlr.  
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Visual settings in Revit  

 

After setting up the line styles, patterns and materials, it is time to have a look where 

these can be used in the Revit project.  

Revit offers a wide range of settings, which will also override each other according to 

their hierarchy – which is probably the reason, why newbies find it so hard to set up their 

views the way they want it.  
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By following the pyramid from the previous page and making sure to start from the 

bottom and work through towards the top, the visual settings can be set up in the most 

efficient way.  

Take care to use project-wide settings were possible, then move the view specific 

settings and store them in view templates. Finally, use element specific overrides only if 

absolutely necessary!  

 

Object Styles  
 

Object Styles belong to the project-wide settings, which means you should use them for 

everything that is valid throughout the project.  The Object Styles can be found under 

the tab Manage just next to the Materials:  

 

 

The dialog offers separate settings for Model, Annotation, Analytical Model and 

Imported Objects and is limited to Line properties and Material overrides:  
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As already mentioned, the categories in Revit are 

hardcoded any cannot be changed. There is no 

way to create own categories, however own 

subcategories can be created for all loadable 

families.  

 

In order to create a new subcategory, follow 

these steps:  

1. Open the family in the family editor 

2. In the family editor, go to Manage > Object 

styles 

3. Create a subcategory by clicking NEW on 

the lower right  

4. Now, select an object that you want to 

assign to this category and change its 

property  

 

Now, once you reload this family into the project, 

the subcategory will be automatically added.  

 

 

 

Note: there is some confusion about 

subcategories, because in the Object Styles 

Dialog in the Project itself you can find the same 

dialog for creating / modifying of Subcategories 

in the lower right. This may seem as if you could 

create Subcategories for system families as well, 

which is NOT true.  

 

This Dialog exists for these two reasons:  

- When creating a project family, you are not using the family editor but the 

project environment and its Object Styles. Therefore, the dialog makes it possible 

to create own Subcategories for project families 

- Custom subcategories created in linked file are not visible in the main project 

they are linked too. However, if you create the same Subcategory in your main 

project, you can drive the appearance of this Subcategory in the linked file as 

well  

 

 

 

Set up everything valid for most of the views in Object Styles. All other 

settings will override these if needed!   
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Visibility / Graphics Overrides 

 
VV is probably the most used keyboard 

shortcut in Revit and opens the Visibility / 

Graphics Overrides dialog, which can also 

be found in the properties of the current 

view or by clicking on Visibility / Graphics in 

the Tab View.  

 

Its dialog box is very similar to Object Styles, 

however it offers some more settings, like 

patterns, transparency or an own detail 

level, which will override the view general 

detail level of the view.  

You can also define filters, which will display 

certain elements in a different way 

according to their properties (e.g. often 

used for coloring fire-proof elements) 
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The Cut Line Styles are an often overseen 

and even more misunderstood feature.  

 

Thanks to this feature, it can be defined how 

the wall layers will behave, which layers will 

have thick lines and which will be displayed 

and how exactly they will be shown on joints.  
 

 
 

 

 

 

 

 

 

 

 

 

The functionality of this option is illustrated below using the following wall structure:  

 

 
 

 
Standard setting as shown above:  

 

 

 
Line Weight for Finish 1 [4] changed from 1 to 2:  

 

 

 
Cut Line Styles unchecked:  
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Note that the dialog offers not only the options for the Line Weights, Line Color and Line 

Pattern, but also for the Core layer clean-up:  

 

 
 

 

 

 

No Edge will always display the joints between layers 

using the same material / function without any separation 

line:  

 

 

 

 

 

 

Use Function will force the display of the separation lines 

for the core. It determines the style of the separating line 

by the layer with the higher priority: 

 

 

 

 

 

 
Use Common Edge Style will ignore function and material 

and will always display the Edge using the Common Edge 

Style.  

 

 

  

If the wall layers don’t seem to display in the desired way, check  

Cut Line Styles in the Visibility / Graphics Overrides dialog (lower right) 
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Phases 

are a very important feature in Revit 

and offer very useful workflows 

when working on project with 

temporary constructions, 

renovations projects or big projects 

involving more construction stages.   

However, phases can also influence 

the way your project is displayed 

tremendously!  

Phases are set up using the dialog in 

the Manage Tab:  

 

 

Apart from setting up the phases themselves, this dialog also offers the setup for the 

Graphic Overrides associate with the phases – note that these will override all settings 

we mentioned until now, including Object Styles and Visibility / Graphics Overrides:  
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All elements created in a project can then be assigned to a phase in its properties. 

Finally, phase filters can be applied to each view so that you can choose which stage 

of the project you are seeing and how the objects are highlighted: 

 

 

 

Elements incl. phasing      Views with applied Phase Filters: 

 

  
 

Phase filters can also be used for other purposes, for example for quickly overriding all 

materials in a project in order to create a homogenous rendering.  

 

  

When looking for an object that actually should be visible but is not 

without any obvious reason, the reason is often the Phase Filter, as this is 

an often overseen option in the view properties. 
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Line Style <Beyond>  

 

This special Line Style is built in and used whenever you set the View Depth different 

from the Bottom of your Floor View. It often creates confusion because the elements in 

this area are not reacting to any changes in Object Styles or Graphics / Visibility 

Overrides. The reason for this is that the Line Style <Beyond> has a higher hierarchy – 

and therefore overrides all settings subjacent settings.  

 

This Line Style can be edited in Manage > Line Styles. 

This is also valid for some other Built-In Line Styles, therefore check these when 

something does not appear the way you’d expect it to.  
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Filters 

 

Filters in Revit are very useful and offer great possibilities for a customized display of 

certain elements based on their properties.  

This is a simple filter collecting all exterior walls. The filter will override all subjacent 

settings!  
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Override Graphics > By Element 

 

This option shouldn’t be used too often, as it is very hard to reproduce. Filter or other 

overrides are easier to recognize and should be used in the first line.  
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Silhouettes 

 

This option, found in the Graphic Display Options of the 

view, will attempt to find all main lines of the building 

and will display them in the desired line style.  

As every automatism, this may work more or less the 

way you expect it to depending on the project. 

 

 

 

 
 

 

 

Linework 

 

Finally, there is also a way to override the 

Line Style of certain lines in a view 

explicitly. This can be especially useful if 

the Silhouettes Option doesn’t deliver the 

desired result in all areas.  

 

After choosing the Linework tool from the 

Modify tab and selected the desired Line 

Style, all edges in the model can be 

selected one by one and overridden.  

 

This option is view and element specific 

only and cannot be included in view 

templates.  
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Understanding Views in Revit 

 
All Views in Revit are just a different representation of a 3D model – the best is to think of 

it as of taking the 3D model and slicing it up in such a way that you only see the 

elements you want to see.  

Floor Plans 

are horizontal slices of your model, cut at a certain height (Cut Plain), allowing you to 

see some elements above and some elements below which are between the Top and 

the Bottom level.  

You can access these settings under View Range in the view properties.  

 

Additionally, you can even see some elements which are between the Bottom level 

and the View Depth – this is often used to display the foundation in your basement 

view. All elements from this area are displayed using the Line Style <Beyond>. 
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Reflected Ceiling Plan 

Is very similar to the floor plan, except that you look UP from the Cut Plane (not down as 

with floor plans) and you don’t see anything what is in your back (or below the Cut 

Plane).  

 

 

 

In addition to the View Range, you can also 

specify an Underlay Range. This Underlay 

can be seen as a second View Range, 

displayed as a ghosted object without the 

possibility to select anything.  

This feature is an analogy to the tracing 

paper, when you need to see what’s 

beneath / above a certain level while 

working on your project.  
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Sections 

Sections are slightly different, they are defined by the Cut Plane and the crop area, 

which can be adjusted manually:  
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Since Revit 2017 there is also a new option called Depth Cueing available in the 

Graphic Display Options for Sections and Elevations.  

This features creates a certain fading effect for elements which are further away from 

the cut plane. The Fade Start/End as well as the Fade Limit can be set in the dialog box:  

 

 

 

 

Elevations 

Are very similar to Sections and offer the same options for Far Clipping and Depth 

Cueing.  

Exterior elevations may not have an active crop region by default, but only a cut plane. 

However, you can activate the crop region by selecting the elevation symbol and 

activating the checkbox “Crop Region Visible” in the properties.  
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Tips 

 

Only elements really CUT by the Cut Plane will be visible in the floor plan view, even if 

they are below the Top plane. This is a kind of confusing and leads to a common 

problem that beams or ceiling transitions won’t be visible in the floor view. There are 

two ways to deal with this:  

 

Editing your families (e.g. Beams):  

- open your beam family in the Family Editor and select the Front view 

- draw a detail line on the Front/Back reference plane starting from the reference 

level / beam and going DOWN ca. 4 m. The line must be long enough so it is later 

cut by the Cut Plane. Set it to be visible in Plan Views only. 

- When you reload your family back to the model it will be visible in the floor view. 

In order to change its appearance, check the subcategory of the beam in the 

family editor and then override its Projection Line settings in the Visibility / 

Graphics Overrides Dialog box.  
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When dealing with more complex families, instead of 

overriding the category, you can also:  

- In the family editor, set the 3D geometry 

completely invisible for Plan views  

- create a symbol line in the plan view showing 

only the edges you wish to see 

- assign the symbol line to a subcategory to be 

able to drive its appearance from the project 

environment 

 

 

 

This will only work for loadable and cuttable families!  

 

For all other cases, you can use the Hidden 

Line Option in Revit. You can turn these on for 

every view and they will behave differently 

according to the View Category.  

 

In most cases, All is not what you want and By Discipline may require some customizing. 

While the option is set to By Discipline, you may include / exclude objects which are 

displayed in the hidden lines style manually: 

- switch your view temporarily to Wireframe  

- Go to the View Tab and select Show / Remove Hidden Lines 

 

 

 

 

 

- First, select an element that is hiding other elements which you want to display 

- Then select the elements which are hidden – these will be then displayed with the 

Hidden Line Style 
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Sometimes, you may want to display just certain edges, e.g. the top of the stairs or just 

the doorframe without too many details. For this, there is a little workaround:  

 

 

- Display the elements by either using another view as an Underlay (great for floor 

plans) or switching to wireframe mode and/or editing the View Range (useful for 

sections / elevations to display slab edges, stairs behind walls etc.)  

 

- Then, use the Linework tool and click all the edges you want to be visible in your 

view 

 

- Once you turn off the Underlay / wireframe mode, the edges that were 

overridden with the Linework tool will remain visible!  

 

Note: the lines will still stay associated to the element – if you select the line, you are 

selecting the element. If you move the element in another view, the line will move.  

 

This is similar to the view option “Hidden Lines”, but it works independently from it and is 

more customizable.   
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Templates 

 

Using the settings discussed until now, it is possible to set up a View Templates and reuse 

all the settings very easily! 

 

To create a view template from an existing view, go to the Project Browser, right-click 

the view and select Create View template from view.  

 

 
 

In the following Dialog box you can uncheck certain categories which should not be 

included in the template:  

 

 
 

The view template can then be either assigned or applied.  
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Assigning a view template is done in the view properties and binds the template with 

the view. This means that all the settings ruled by the template will be greyed out and 

can be edited new in the view template itself.  

In addition, as soon as a settings is changed in the view template, it will be 

automatically visible in all views this template it assigned to.  

 

 
 

Applying a view template can be done by right-clicking the view in the project 

browser. This will override all view settings by the one of the template, however it won’t 

create a connection between the view and the template. Changes in the view 

template won’t be visible in the views, unless you re-apply it.  

 

 
 

 

View templates are an important part of the Revit Project Templates.  
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The Project Template in Revit is nothing else but a project file without any modeled 

content saved as an .rte file.  

In order to create a template, you can either start from scratch by going to Revit > New 

> Template, or you can use an existing project where everything has been set up, then 

clean it up leaving only the bits intended for the template and going to Save as > 

Template.  

 

  
 

 

 

The Revit Project Template contains in general:  

- View Templates 

- All general settings discussed here and not included in the View Templates like 

Line Styles, patterns, but also last used tool settings. For example, if you want your 

Structural Walls to be modelled UP and not DOWN like in the default template, 

change this setting, draw a wall in your template and then delete it. Revit will 

remember the last used settings and will store it with the file!  

- Families: all loadable and system families – make sure to include only the ones 

that are necessary for the template, in order to avoid blowing it up.  

 

Once the template has been saved, go to Revit > Options > File Locations and add its 

path: 
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Power Tips  

 

Appealing shading views 

 

Use following settings to create nicely shaded views:  

 

 
  

Activate anti-aliasing to reach a 

more smooth line style on your 

screen. This is especially useful 

when creating screenshots, but 

it will use some more computing 

power.   

Activate ambient shadows to 

reach a smoother, more 

realistic look in your shaded 

views.  

Change the default lighting 

settings to avoid too dark 

looking shadows. Depending on 

your project and materials, 

these may vary, but usually 

settings for Sun in the upper 

third, Ambient light around the 

middle and the Shadows in the 

lower third will deliver best 

results. 
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White cardboard model  

 

Often we don’t want all the materials and textures to be displayed. There is a nice little 

trick how you can quickly override (almost) all materials in a view:  

- Open Visibility / Graphics Overrides dialog 

- Click Select All 

- Click Expand All to see the subcategories 

- Click again Select All to select the categories as well  

- Now click in one of the Projection/Surface Patterns and choose a light grey Solid 

fill 

 

 
 

This will color everything in your view – except the Topography and Planting (for these, 

you need to (temporarily) assign another materials. Change the material for 

Topography in its Type Properties and override and Planting Material using Objet Styles). 

In order to make it look more realistic, edit the transparency for Windows / Façade or 

turn off their Subcategories:  
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Exploded Views 

 

Create Displacement sets in Revit in order to 

visualize more complex structures. With this 

function, it is possible to more objects in one 

view only – the model itself stays 

untouched:  
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3D Sections 

 

In a 3D View, right-click the ViewCube and select 

Orient to View > Sections > choose a section.  

 

The View will now be oriented to the section and you 

can rotate it or crop it.  

 

In order to override the Cut Patterns, go to Visibility / 

Graphics overrides (VV), select all Categories and 

Subcategories, click on Cut Patterns and assign a 

Solid color, e.g. red like in this example:  

 

If using the coarse detailing, you can skip overriding the cut patterns in Visibility 

Graphics and just edit the Coarse Poche Material in the Type Properties of the view. 

Note that this doesn’t work for Medium and Fine!  

 

Of course, the same workflow can be used for Floor Views as well.  

By locking the view, dimension lines and text can be added.  
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Based on these settings, the documentation in Revit can be set up in such a way that 

they can even be used for presentations without any further editing: 

 

 

 


